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Maya and Alias MotionBuilder in a Production Pipeline 
Presenter:      Marc-André Guindon 
       Realities Studio, Quebec, Canada 
 
OVERVIEW 
 
This course covers a typical pipeline using both Maya® and MotionBuilder®.  Whether you 
need to produce a feature film or come up with the latest game, most likely you will need a 
place for animation in your pipeline. Animation is the process of taking 3D characters or 
objects and moving them over time.  This procedure usually takes time due to many artistic 
and technical issues. Typical technical issues can be a model’s weight in geometry, 
hardware limitation or poor playback speed. This is where MotionBuilder can come in very 
handy. 
 

 
Our example characters from the 
Outlaw Golf game by Hypnotix 

 
First, we will go over some features of MotionBuilder, and then, with a practical example, 
we will explore how to use Maya and MotionBuilder together. 
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I. Maya and MotionBuilder United 
 

While Maya was made to take care of an entire pipeline, MotionBuilder was designed to 
deal mostly with animations. Since one enhances the other, it is possible to unite them 
into a single pipeline. 

 
PART I What is MotionBuilder? 

 
Main Differences and Advantages 
 
Interface 
The most striking difference between Maya and MotionBuilder is that MotionBuilder 
doesn’t have as many tools as Maya. For example, there are no modeling tools. 
You might think that this is a drawback at first, but you will soon come to realize that 
MotionBuilder is able to much more efficiently handle heavier models than Maya, since 
it doesn’t have all the variety of history, modeling, dynamic and deformer nodes to 
evaluate. 
 

 
The MotionBuilder interface 

 
Animation Method 
Another great difference is how MotionBuilder handles animation. There are two basic 
animation techniques: keyframe animation and device animation. With keyframe 
animation, you will have to animate manually from scratch. With device animation, such 
as motion capture, you will need to record a performance, which will then be applied 
onto your character.  
 
Both Maya and MotionBuilder exploit those techniques, but MotionBuilder has many 
powerful tools to help you tweak animations. 
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Motion capture animation / keyframe animation 

 
Takes 
A scene in MotionBuilder can have multiple animation takes. Each take contains a 
whole new animation for all the models in your scene. It is not possible to have multiple 
takes in Maya; different animations need to be in different files. 
 

 
Scene takes menu 

 
Layers 
You can use animation layers in MotionBuilder, which can greatly speed up any 
modifications. Once you are done tweaking your animation, you can merge all the 
layers together into the base layer. This whole process also makes it easy to refine a 
motion when used in conjunction with a character rig. 
 

 
Layers in FCurves window 
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Motion Blend Tool 
Maya has Trax, as MotionBuilder has Motion Blend. These tools are similar, but the 
Motion Blend tool can give you much more control over your animation. 
 

 
Motion Blend window 

 
Note: Make sure to select and drag only the appropriate nodes in the Motion Blend 
window. A common error is to drag a top node not intended for animation. 
 
Control Rigs 
In Maya, you can create complex character rigs for your animations, which can slow 
down the interaction with your model. In MotionBuilder, a default character rig for bipeds 
and quadrupeds, which implements IK and FK, can be used to manipulate a skeleton. 
 

 
Quadruped control rig 

 
Mirroring Animation 
The character rig allows you to mirror animation on the Z plane in a single click. This is 
something that requires scripting in Maya in order to be done. 
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Mirror control rig 

 
Retargeting 
If your character uses a MotionBuilder rig, you get character retargeting for free. That 
means that you can copy any character rig animation to any other similar rig with a few 
mouse clicks. 
 

 
Retargeting between characters 

 
Real Time Engine 
When you play animations on high-resolution models in MotionBuilder, the refresh rate 
will most likely be higher than Maya. 
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MotionBuilder usually gets more FPS than Maya 

 
Constraints 
The constraints in MotionBuilder are similar to those of Maya with the Maintain Offset 
option. The only difference is that the constrained object’s properties can still be offset 
with the manipulators. It is also possible to lock or zero a constraint offset. 
 

 
Constraints setup in the Navigator 

 
 
Special Constraints 
There are two special types of constraints in MotionBuilder, called Expression and 
Relation constraints. Compared to Maya, the Expressions constraint works like a simple 
mathematical MEL expression, and the Relation constraint is just like connections, but 
they can be turned on and off and blended like any other constraints. 
 

 
Relation constraint setup 
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We will see later in the course that the Expression and Relation constraints can get 
input from devices such as mouse, keyboard or joystick.  If you setup that kind of 
relation and press the record button, you can animate objects and characters in real 
time.  A common use for this is to control blendshape while an animation is playing 
back. 

 
PART II Using a Maya / MotionBuilder Pipeline 

 
What goes in and out 
Here is a list of the unsupported Maya nodes for MotionBuilder: 

• Curves 
• Subdivision surfaces 
• History nodes (other than skinning and Blendshapes) 
• Dynamics 
• Some material and shader type 
• Set Driven Keys, connections and expressions 
• Constraints 
• IK handles 
• Visibility Layers 
• Paint Effects, fur, cloth, hair, etc. 
• Custom nodes 

 
Here is a list of the unsupported MotionBuilder nodes for Maya: 

• Constraints 
• Actors and characters 
• Animation layers (must be merged) 
• Multiple takes (only one at the time can be imported) 
• Devices 
• Camera switcher 
• Shaders (materials are OK) 
 

If you need a more specific understanding of what gets exported from Maya and 
imported from MotionBuilder, get the documents related to your FBX plug-in version. 
This list is subject to change. The best way of knowing if something goes through is to 
try it out. 

 
Pros and Cons 
In all scenarios, the biggest disadvantage is ignorance. Most people think MotionBuilder 
is only motion capture software, but that is really not the case. MotionBuilder is also a 
very powerful previz and animation software. 
 
A basic knowledge of the software is required in order to evaluate if it is worth it or not to 
export your characters to MotionBuilder. Once a decision is taken, make sure your rig 
and naming is final; if not, you might have problems importing the animation back in 
Maya. 
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A common mistake using MotionBuilder is to think motion capture is better than 
keyframe animation or reverse. Some people will say keyframe is better and others will 
say mocap is better. Motion capture might be faster to get results, but it usually needs 
cleanup, tweaking and overlaid animation. Animation is a slower process, but the results 
pinpoint what you wanted to the smallest detail. Experience with both techniques is the 
only way to really decide which one will be advantageous for your project. 
 
The learning curve of new software can be somewhat rough. Fortunately for beginners, 
MotionBuilder offers you the option to interact with your scene with a Maya hotkey 
layout. 
 
Also, using the character rig might not be efficient at first, but keep in mind that, 
animators who get experienced with it find it very useful. 
 

 
Set the Maya keyboard layout 
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II. Maya / MotionBuilder Example 

 
The basics of a Maya / MotionBuilder pipeline are simple but require some extra work to 
be done prior to converting your model to MotionBuilder. In this example, we will use 
Clemor and Harley, characters from the Hypnotix game studio. They will be animated in 
MotionBuilder using motion capture and keyframing, and then brought back into Maya for 
final tweaking. Doing so allows creating and modifying our animation in real time using 
the powerful display engine of MotionBuilder. 

 
PART I What Needs to be Done in Maya? 

 
Modeling 
MotionBuilder supports polygon and NURBS geometry, but no history nodes will be 
exported. For example, a polySmooth node or a trimmed surface will not be exported. It 
is also recommended to freeze geometry before exporting. 
 

• Start off by opening a character in Maya. In our case, we will open Clemor_FK.ma. 
 

 
Clemor facing the Z-axis in T-stance 

 
• It is important to have your character in perfect T-stance, facing the Z-axis. The 

MotionBuilder rig will be more accurate this way. If your character is not in a T-
stance, you can always rotate its skeleton once skinned to place it in a good 
position. Obviously, the T-stance does not apply for quadrupeds. 

• MotionBuilder will like your model better if there is no negative scaling or pivot offset. 
The rule of thumb is to make sure your geometry is frozen, using Modify > Freeze 
Transformation. 

• Keep in mind is that no history node will be exported beside skinning and 
Blendshapes. In the case of blendshape nodes, you need to have the actual shapes 
in your scene prior to export. If you don’t have the shapes, use a script to extract the 
shapes automatically, then recreate the blendshape node. 

 
Rigging 
Any type of Maya skinning is perfectly supported by MotionBuilder. 
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Rig nodes, other than bones and groups, will be exported as nulls. In fact, the only thing 
you really need in order to animate a character in MotionBuilder is an FK skeleton. No 
need for IK handles, since the character rig will take care of that for you. 
 
However, if you need IK handles to be animated once back in Maya, you can use the 
nulls created by the exporter as parts of constraints. There are two possibilities: 
constrain the locators to the bones and plot them once animated, or create IK handle 
constraints to mimic your Maya rig. Either solution will import back the animation 
correctly in Maya. 
 

 
IK constraint setup 

 
• You can now rig the character with bones, using parenting, smooth or rigid binding. 

Since all our animations will be done in MotionBuilder, we don’t need a fancy setup; 
simple forward kinematics will do the job. 

 
Naming 

• If you want to simplify the character rig setup in MotionBuilder, your skeleton needs 
to be named a certain way. This step is not required, but it will save you time in the 
process. 

 
 

Hips 
Spine (1, 2, 3 …) 
Neck (1, 2, 3 …) 
Head 
 
Left/Right UpLeg 
Left/Right UpLegRoll 
Left/Right Leg 
Left/Right LegRoll 
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Left/Right Foot 
Left/Right ToeBase 
Left/Right Shoulder 
Left/Right Arm 
Left/Right ArmRoll 
Left/Right ForeArm 
Left/Right ForeArmRoll 
Left/Right Hand 
Left/Right FingerBase 
 
Left/Right Hand/Foot Thumb (1, 2, 3, 4) 
Left/Right Hand/Foot Index (1, 2, 3, 4) 
Left/Right Hand/Foot Middle (1, 2, 3, 4) 
Left/Right Hand/Foot Ring (1, 2, 3, 4) 
Left/Right Hand/Foot Pinky (1, 2, 3, 4) 
Left/Right Hand/Foot ExtraFinger (1, 2, 3, 4) 

 
Note: There are no spaces within the names 

 
• MotionBuilder will support identical names from Maya, but it will append its own 

suffix in order to be able to recognize the nodes individually. This will also import 
your animation correctly back in Maya. 

 
Texturing 
UVs and materials are supported by MotionBuilder, but the Maya material attributes 
might not give the exact same result. You might need to tweak the shaders and 
materials in MotionBuilder in order to get a similar look. 
For this example, materials are not very important since we know we are going back 
into Maya. 
 

 
Material panel 
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Exporting 
When a character is ready to be exported to MotionBuilder, all you need to do is to load 
the FBX plug-in and select File > Export All. A window will then pop-up, letting you 
choose from some export options. If any problems occur during this task, the plug-in will 
warn you. If everything goes well, an FBX file will be written to disk. 
 
Note that prior versions of MotionBuilder 6.0 were backward and forward compatible, 
but MotionBuilder 6.0 FBX file format was revised and it might not be read correctly by 
previous versions. 

 
• In order to export, you need to place the fbxmaya<version>.mll plug-in in the 

appropriate Maya Plug-ins directory and then load it through the Plug-in Manager. 
 

 
Maya Plug-in manager 

 
• Once you export to FBX file format, the plug-in options are displayed. Here, you can 

specify weather you want to reduce constant animation keys and specify a 
resampling frame rate. You can specify if you want to export polygonal edge 
information and if you want to embed textures in the FBX file. 

 

 
MotionBuilder export window 
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PART II Using MotionBuilder 

 
Setting up your Character 
You will need to setup your character once in MotionBuilder in order for the software to 
“understand” the structure of your hierarchy. Here you can give your model a proper 
scaling, create special constraints and, most important, map your model’s skeleton to a 
Character. 
 
The Character constraint will control your character based on various input, such as 
motion capture, its character rig (FK, IK or both) or even another Character constraint. 
 

 
Character setup 

 
• Open your exported FBX file with MotionBuilder. 
• Some steps are required in order to set up the character rig. If you have named your 

skeleton with the MotionBuilder convention, you can automatically map the 
character. If not, you will need to do it manually for each node. 

 

 
Automatic mapping in a click 
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• If your character is a quadruped, you can also create a quadruped character rig. 
• Save your scene as being the rigged character. 

 
Motion Capture 
Now that MotionBuilder knows the structure of your character, you can start animating. 
That can be done using any supported motion capture device, straight keyframing or 
through another character. For our example, we will use optical motion capture data. 

 
• Create a new scene and import 00_ROM.c3d and 01_mocap.c3d. 
• You now need to create an actor to follow the optical markers. The actor constraint 

works with the character constraint, which will in turn, drive your skeleton. 
• In order to get better results out of your mocap data, you need to use rigid bodies. A 

rigid body will constrain a group of markers together, which will mimic a stiff body 
part, such as the chest or the head. That way, if you lose a marker in a group, the 
other markers will attempt to place it to its estimated position. 

• It is now time to cleanup the mocap segments using the optical panel. 
 

 
Optical panel 

 
• Now that the data is cleaner, it is recommended to use optical filter, which shall 

smooth out the animation curves. 
 

 
Optical filter panel 
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Character Rig 
All you have to do at this stage is to specify an input type for your control rig and adjust 
its properties to best fit your animation. 
 

 
Control rig with pull enabled 

 
• Append the rigged character to your scene and constrain it to follow the actor. 
• You can play with several options susceptible of improving the assignation of the 

character to the actor. 
• Once you are happy with the rig reaction, you need to plot the animation from the 

actor to the rig itself. 
 

 
Plot options 

 
The character constraint has several possible input and output. It can retrieve 
animation from an actor, another character or its skeleton, and it can give its 
animation to its skeleton. 
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Character input types 

 
Keyframes and layers 
Now is the time to take advantage of powerful tools such as layers, takes and motion 
blend. 
 

• Most of the time, you will have to tweak your animation to best fit your model. To do 
so, you need to keyframe over the mocap using layers. 

• The Character Controls window allows you to quickly interact with the rig. Several 
options can be used such as pinning in translation and rotation, pulling and 
auxiliaries. 

• When keyframing the rig, it is possible to do it on layers, which are added to the 
base animation. What you see in the perspective is the result of the base layer plus 
all the added layers. 

• When you are done, you need to plot the animation to the skeleton. Doing so will 
disable the rig and show you the bones animation which can be imported back in 
Maya. 

• Perhaps one of the most powerful tools of MotionBuilder is the Motion Blend tool. 
Here you can loop a take, blend multiple takes and redirect motions. You can then 
process the result to a new take. 

• Before going back to Maya, you might want to do some more animation. 
Blendshapes for example can be hooked up to the keyboard and recorded as the 
animation and sound plays. This allows you to quickly establish facial animation. 

 

 
Keyboard hooked to Blendshapes 

 
• For lip-synching, you can use the Voice Reality tool, which will attempt to recognize 

the phonemes spoken in a dialog. 
 

 
 

PART III Back to Maya 
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Importing the Data 
Once you are happy with your animation, you need to plot your animation on the 
character bones. Plotting an animation works exactly like “bake” in Maya. Once that is 
done, you can do some cleanup in your scene then save it so the importer can get it into 
Maya. Cleanup means that you can get rid of unused nodes such as old motion capture 
makers, old constraints or reference geometry. 
 
Note that not all MotionBuilder nodes go through the importer. 
When in Maya, if you select File > Import and choose an FBX file, you will be prompted 
with an option window. Here you can choose if you want to import the animation of the 
FBX file in a new scene or to merge with the current scene. The merging option is very 
powerful, as it will assign the animation to the nodes with the same names. 
If you had constrained locators, for example an IK handle, which was plotted in 
MotionBuilder, merging it in Maya will cause the IK handle to be animated. 
 

• Your animation file can now be either imported in Maya or merged to the current 
scene. If you merge the FBX file the current Maya scene, every matching name will 
get its respective animation. Since Maya does not support multiple takes, you have 
to specify which take you want to import.  The other import options will change what 
and how the file is imported. 

 
Character input types 

Workaround 
It is a little more complicated if you want to import the animation on a reference, since 
Maya will add a prefix to each node. In that case, retrieve your animation by importing 
the FBX file in a new scene and then export an anim file. Import it back on the 
referenced character. 
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Rest of Maya Pipeline 
From here, you can go on with your Maya pipeline. If you want to use dynamics or any 
other post animation process which could not be done in MotionBuilder, now is the time 
to do it. At any time, you can go back in MotionBuilder, tweak the animation, and then 
merge it again over your models. 
 
Reusing and Blending Animations from Maya 
If you already have an animated character in Maya for which you would like to use the 
MotionBuilder Motion Blend tool, it is possible to do so.  The solution might not be 
pretty, but it is possible. Doing so could potentially save you time, generating new 
animation from existing ones. 
Simply export your character as is, correcting any issues revealed from the exporter. 
Note that custom attributes will be correctly exported with animation (but not 
connected). 
 
In Motion Builder, select all the animated nodes and drop them in the Motion Blend 
window. Now generate your new animations from various takes. 
Save and import the file back in Maya. It might be better to then export your animation 
with animExport and import it back onto your original character. 
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III. Tools and Scripts 
 
Advanced users with coding knowledge can push the limits even more by using 
embedded scripting languages and software development kits. Even though Maya and 
MotionBuilder are quite differ programmatically, they both offer the possibilities of creating 
scripts, macros or custom tools for your pipeline.  

 
PART I Custom Tools 

 
Scripting languages 
While you can use MEL in Maya to automate tasks, you can use Python scripting in 
MotionBuilder. Note that the scripting language in MotionBuilder is fairly young and not 
as powerful and intuitive as MEL, but you can still automate tasks with it. Scripting is 
available only for MotionBuilder Pro and higher. 
 

 
Dragging a Python script 

 
Software Development Kit (SDK) 
Just like Maya, MotionBuilder has a powerful SDK letting you create utilities for your 
convenience. The only drawback is that MotionBuilder Standard does not support plug-
ins. 
At Realities, we are using plug-ins to get customizable solutions, such as hotkeys and 
menu items. Doing so considerably speeds up repetitive tasks. 
 

 
RealPlugin menu 
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IV. Conclusion 
 
Based on what you’ve just experienced, you probably now have a bettering 
understanding of the advantages of combining tools from both Maya and MotionBuilder. 
Although it depends on your needs, using such a pipeline can drastically speed up any 
animation tasks. It is now up to you to exploit those tools to your advantage. 
 
For more information about Realities Studio, visit http://www.RealitiesStudio.com. 
 
If you have any questions, comments or concerns about this course or our plug-ins for 
MotionBuilder, you can post these on the Realities forum at 
http://forum.RealitiesStudio.com. 

 
 

 
  www.RealitiesStudio.com 
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